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CMW500 Hands On
LTE Carrier Aggregation 



The LTE-CA Hands ON session requires following 
items:
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ı A CMW500 loaded with the following Hardware
� CMW-B590D x2 – Advanced Front End
� CMW-B570B x4 – Transceiver Module
� CMW-B300B x2 – Signaling Unit Wideband
� CMW-B450B x1 – Data Application Unit
ı CMW Signaling Software Applications

� CMW-K0
ı CMW Firmware

� BASE 3.2.20
� DAU 3.2.11
� LTE 3.2.50
ı A Samsung Galaxy S4-A supporting LTE Carrier Aggregation (LTE Band3+LTE 

Band5)
ı A Valid Test SIM Card

� CMW-Z04



RESET CMW and MAP LTE Signaling Application

ı Reset the CMW
� Use the “Close” tab to close all the 

open windows
� Press the “RESET” key
� Select “Preset” tab

ı Map the LTE Signaling Application
� Press the “SIGNAL GEN” tab
� Scroll in the Generator/Signaling 

Controller windows and locate the 
LTE Signaling entry

� Checkmark the LTE Signaling 
TaskbarEntry

� Hit the “LTE Signaling” hot tab at the 
bottom of the CMW display
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TEST in TEST MODE Connection

ı Set the CMW for Carrier Aggregation 
Mode
� Press the “Config” tab
� Press the “PCC” tab
� Expand the “Scenario” entry and 

select the “Carrier Aggregation –
Four RF Out Ports”

ı Set CMW for Test Mode
� Uncheckmark the “Enable Data end 

to end”
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Set the Primary Component Carrier Cell – Step1

ı Press the “PCC” tab
ı Expand the “RF Settings” entry

� Expand the “RF Output (TX)” entry
� Set Out1 Connector to “RF1COM” port
� Set Out1 Converter to “RFTX1”
� Set Out2 Connector to “RF3COM” port
� Set Out2 Converter to “RFTX2”

ı Expand the “RF Input (RX)” entry
� Set In Connector to “RF1COM” port
� Set In Converter to “RFRX1”

ı Expand the “RF Frequency” entry
� Set the “Operating Band” to “Band 3”
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Set the Primary Component Carrier Cell – Step2

ı Expand the “Network” Entry
� Expand the “Security Settings” entry
� Set the “Integrity Algorithm” to 

“SNOW3G(EIA1)”

ı Expand the “Connection” Entry
� Set the “Connection Type” to 

“Testmode”
� Checkmark “Downlink MAC Padding”
� Change “Scheduling Type” to “User 

Defined Channels”

ı Expand the “User Defined Channels”
� Expand the “DL” entry
� Set the “Transport Block Size Index” 

to “9”
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Set the Primary Component Carrier Cell – Step3

ı Expand the “User Defined Channels”
� Expand the “UL” entry
� Set the “Transport Block Size Index” 

to “9”

ı Expand the “PDCCH” entry
� Checkmark “Reduced PDCCH”

ı Set the “Operating Band Change” to 
“Redirection”
ı Set the “Frequency Change” to 

“Redirection”

ı Checkmark “Accept Multiple 
Def.Bearer”
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Set the Secondary Component Carrier Cell – Step1

ı Press the “SCC1” tab
ı Set the “SCC Activation Mode” to “Manual”
ı Uncheckmark “Enable Data end to end”
ı Expand “RF Settings” entry

� Expand the “RF Output (TX)” entry
� Set Out1 Connector to “RF1COM” port
� Set Out1 Converter to “RFTX3”
� Set Out2 Connector to “RF3COM” port
� Set Out2 Converter to “RFTX4”

� Expand the “RF Input (RX)” entry
� Set In Connector to “RF1COM” port
� Set In Converter to “RFRX1”

� Expand the “RF Frequency” entry
� Set the “Operating Band” to “Band 5”
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Set the Secondary Component Carrier Cell – Step2

ı Expand the “Network” Entry
� Expand the “Security Settings” entry
� Set the “Integrity Algorithm” to 

“SNOW3G(EIA1)”

ı Expand the “Connection” Entry
� Set the “Connection Type” to “Testmode”
� Checkmark “Downlink MAC Padding”
� Change “Scheduling Type” to “User 

Defined Channels”

ı Expand the “User Defined Channels”
� Expand the “DL” entry
� Set the “Transport Block Size Index” to 

“9”

09.10.2013 Footer: >Insert >Header & Footer 9



Set the Secondary Component Carrier Cell – Step3

ı Expand the “PDCCH” entry
� Checkmark “Reduced PDCCH”

ı Set the “Operating Band Change” to 
“Redirection”
ı Set the “Frequency Change” to 

“Redirection”

ı Checkmark “Accept Multiple 
Def.Bearer”

09.10.2013 Footer: >Insert >Header & Footer 10



Attach DUT
ı Close the Config screen
ı Press the “PCC” tab
ı Press the hot tab “LTE Signaling”
ı Press the “ON/OFF” tab to start the LTE cell

� Wait until the message “State ‘Cell On’” 
appears in the “Event Log” frame

� At this time the CMW is waiting for a DUT 
to Attach

ı DUT RF Connection
� Connect the primary RF port of the DUT to 

the CMW RF connector “RF1COM” 
� Connect the secondary RF port of the DUT 

to the CMW RF connector “RF3COM” 
ı Power ON the DUT

� The DUT has successfully attached when 
the “Packet Switched” state in the 
“Connection Status” frame is “Attached”
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Check Throughput using PCC Cell

ı Press the “LTE1 Ext. BLER” tab
ı Select the Throughput Overall screen

� Press the “Display” tab
� Press the “Select View” tab and 

select the “Throughput”
� Press the “Overall” tab
ı PCC Throughput test

� Press the “Extended BLER” hot tab
� Press the “ON/OFF” tab
� As only the PCC cell is activated 

you only see valid Throughput 
measurement in the “Overall” and 
“PCC” fields

ı Press the “LTE signaling” hot tab 
twice to exit
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Establish SCC carrier

ı Establish the SCC carrier in 3 steps
� Press the “SCC On” tab
� Press the “SCC add RRC” tab
� Press the “SCC activate MAC” tab

ı When the “SCC1 State” is “MAC 
Activated” under the “Connection 
Status” Frame, the DUT has 
established the call with the SCC 
carrier
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Check Throughput Test with PCC and SCC carriers

ı From the Signaling screen, Press the “LTE 
1 Ext.BLER” tab
ı Select the Throughput Overall screen

� Press the “Display” tab
� Press the “Select View” tab and select 

the “Throughput”
� Press the “Overall” tab
ı PCC and SCC Throughput test

� Press the “Extended BLER” hot tab
� If the BLER Measurement is not running, 

press the “ON/OFF” tab
� Observe that the Overall PCC and 

Overall SCC Measurements are now 
working

� The Absolute Overall Throughput 
measurement displays the total 
throughput over the 2 carriers
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MAX Throughput Test using PCC and SCC carriers
ı Change Scheduling

� From the Extended BLER screen, Press 
the “Signaling Parameters” tab

� Press the “Connection Setup” tab
ı Change PCC scheduling

� Press the “PCC” tab
� For “Downlink”, change “Mod” to “64-QAM”
� For “Downlink”, change the “TBSI” to “26”
ı Change SCC scheduling

� Press the “SCC1” tab
� Change the “Mod” to “64-QAM”
� Change the “TBSI” to “26”
ı MAX Throughput over 10 MHz bandwidth

� Close the Connection Setup windows
� Observe the Absolute Overall Throughput.
� Maximum Throughput is 2 * 73.392 Mbit/s 

= 146.784 Mbit/s
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Disconnect the CA Call

ı From the LTE Signaling screen, press 
the “LTE Signaling” tab

ı Disconnect the SCC cell
� Press the “SCC deactivate MAC” tab
� Press the “SCC delete RRC” tab
� Press the “SCC Off” tab

ı Disconnect the PCC cell
� Press the Detach tab
� At this point, the S4-A goes          

“out of Sync”
ı Turn OFF the LTE cell

� Press the “LTE signaling” tab
� Press the “ON/OFF” tab
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LTE CA Test In DATA end 2 end Mode
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Setup the CMW for LTE-CA end 2 end Connection

ı Ensure the LTE cell is OFF
ı Press the “Config” tab
ı Scroll up to the top of the screen and 

checkmark “Enable data end to end”

ı Set the PCC cell
� Press the “PCC” tab
� Expand the “Connection” entry

� Set the “Connection Type” to “Data 
Application”

� Uncheckmark “Downlink MAC 
Padding”

� Set the “User Defined Channels – DL” 
scheduling to:
� “Modulation Type”: “QPSK”
� “Transport Block Size Index”: “9”
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Setup the CMW for LTE-CA end 2 end Connection

ı Set the SCC cell
� Press the “SCC1” tab
� Expand the “Connection” entry

� Set the “Connection Type” to “Data 
Application”

� Uncheckmark “Downlink MAC 
Padding”

� Set the “User Defined Channels – DL” 
scheduling to:
� “Modulation Type”: “QPSK”
� “Transport Block Size Index”: “9”
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Map the Data Application Measurement

ı Press the “PCC” tab
ı Expand the “Shortcut Softkey”
ı Change the “Select Menu 3” to “Data 

Application Measurement”
ı Checkmark the “Select as fixed 

Target 3”

ı Close the Config screen
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Start DAU services
ı From the LTE signaling screen, press the 

“Data 1 Meas” shortcut key
ı Press the “Configure Services” tab
ı Start DNS server

� Press the “DNS Server” tab
� Press the “ON/OFF” tab
� Wait that the service is ON
ı Start FTP server

� Press the “FTP Server” tab
� Press the “ON/OFF” tab
� Wait that the service is ON
ı Start HTTP server

� Press the “HTTP Server” tab
� Press the “ON/OFF” tab
� Wait that the service is ON
ı Press the “Close” tab
ı Press the “Go to RAN” tab to switch back 

to the LTE Signaling screen
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Setup the DUT for a Data Call

ı Load Application on the DUT

� Connect the DUT via WIFI to the 
Google Play Store

� Download and install the following 
applications:

� Ping&DNS
� Iperf
� AndFTP
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Setup the DUT for a Data Call
ı Create An access point

� In the Android “Settings” Menu, 
choose “More networks”, then 
“Mobile networks”, then “Access 
Point Names”

� Press the bottom left (Menu) key on 
the S4-A and choose “+ New APN”

� Create a dummy Access Point with 
the Name CMW and the APN name 
CMW.

� Activate the Access Point (if it isn’t 
already activated)

ı Power OFF the DUT

09.10.2013 Footer: >Insert >Header & Footer 23



Establish The Data Call 

ı Start LTE call from a LTE-CA Data end 2 
end call
� From the LTE Signaling screen, press 

the “LTE Signaling” tab
� Press the “ON/OFF” tab to start the cell
� Wait for the message “State ‘Cell On’”
ı Power ON the DUT.
ı After the DUT Attach to the PCC cell, 

ensure a valid IP address appears in the 
UE Info box under “UE IPv4 address” 
and/or “UE IPv6 Prefix“
� Default UE IPv4 address starts at 

172.22.1.100
ı Establish the connection with the SCC cell

� Press “SCC On” tab
� Press “SCC add RRC” tab
� Press “SCC activate MAC” tab
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Change Scheduling to the MAX Throughput
ı Change the scheduling for the PCC cell

� From the LTE signaling screen, Press 
the “PCC” tab

� For “Downlink”, change “Mod” to “64-
QAM”

� For “Downlink”, change the “TBSI” to 
“26”

ı Change the scheduling for the SCC cell
� From the LTE signaling screen, Press 

the “SCC1” tab
� Change the “Mod” to “64-QAM”
� Change the “TBSI” to “26”

ı Maximum Throughput is 2 * 73.392 
Mbit/s = 146.784 Mbit/s
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Ensure IP connectivity is established
ı Ensure IP connectivity from CMW DAU to DUT

� Press the “Data1 meas” tab from the LTE 
Signaling screen

� Press the “Ping” tab
� Under “Destination IP” set the DUT IP address 

(which can be read from the “UE Info” frame in 
the LTE Signaling view; example:172.22.1.10x)

� Press the “Ping” hot tab
� Press the “ON/OFF” tab
� Observe the Ping graphical windows. Vertical 

bar should comes at interval of 1 s
ı Stop the Ping

� Press the “ON/OFF” tab
ı Check IP Connectivity from DUT

� Open “PING&DNS” tool
� Enter the DAU IP address 172.22.1.201
� Select the IP address
� Select the “PING” application
� Press “Go” tab
� Ensure the Ping to the DAU comes back with 

valid data
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Setup DUT Iperf tool and CMW DAU Iperf
Application
ı Start Iperf tool on the DUT

� Run Iperf as a server tool by entering the 
following parameters:
� “-s –i1 –w192k –p5010”

� Start Iperf by pressing the “OFF” tab
� Locate the DUT IP address displayed in the 

Iperf tool (172.22.1.10x)

ı Setup CMW DAU Iperf tool
� Press the “Iperf” tab
� Press the “Config” tab
� Expand the “Clients” entry
� Checkmark the “Use” from  the 1st row of the 

Clients entry 
� Set the “UDP or TCP” to “TCP”
� Set the “Port” to “5010”
� Set the “UE IP Address” to 172.22.1.10x
� Set the “Win. size (in kByte)” to “384”
� Set the “Parallel Conn.” to “4”
� Press the “OK” tab
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TCP/IP Throughput Test
ı Start DAU Iperf Application

� Press the “Iperf “ hot tab
� Press the “ON/OFF” tab
� Check that a vertical green bar shows up in 

the Graphical windows
� Check that a valid Throughput is displayed in 

the Downlink field
ı Check IP Throughput over time

� Press the “Throughput” tab
� Press the “Throughput” hot tab
� Press “ON/OFF” to start the Throughput 

Measurement
� Check the TCP Throughput

ı Check TCP Throughput on DUT
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TCP/IP Throughput Test

ı Check MAC Throughput
� Press the “Go To RAN” tab
� Press the “LTE 1 Ext.BLER” tab from the LTE 

Signaling screen
� Press the “Extended BLER“ tab
� Press the “ON/OFF” tab
� Check the Overall Absolute Throughput
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